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Abstrak  

Tujuan dari laporan ini adalah untuk membuat sistem informasi akuntansi untuk CV Era Komputer 

Palembang, perusahaan yang menjual perangkat komputer dan menyediakan jasa. Penulis 

menggunakan wawancara langsung untuk mengumpulkan data. Hasil wawancara menunjukkan 

bahwa perusahaan masih melakukan pencatatan penerimaan dan pengeluaran kas secara manual, 

yang memungkinkan kesalahan manusia atau kesalahan manusia. Selain itu, perusahaan tidak 

menyusun laporan arus kas bulanan, sehingga tidak mungkin untuk melihat jumlah kas bersihnya. 

Penulis menyarankan untuk memperbaiki sistem lama dengan membuat sistem informasi 

akuntansi penerimaan dan pengeluaran kas. Sistem ini akan menghasilkan laporan arus kas untuk 

menyelesaikan masalah. Dalam diskusi ini, mereka membuat rancangan sistem yang disesuaikan 

dengan kebutuhan perusahaan. Dalam proses perancangan, penulis menggunakan teknik System 

Development Life Cycle (SDLC). 

Keywords: Sistem Informasi Akuntansi, Penerimaan dan Pengeluaran Kas, Microsoft Access.   

 

Abstract  

The purpose of this report is to create an accounting information system for CV Era Komputer 

Palembang, a company that sells computer equipment and provides services. The author uses direct 

interviews to collect data. The results of the interviews show that the company still records cash 

receipts and disbursements manually, which allows for human error or human error. In addition, 

the company does not prepare a monthly cash flow report, making it impossible to see the amount 

of net cash. The author suggests improving the old system by creating a cash receipt and 

disbursement accounting information system. This system will produce a cash flow report to solve 

the problem. In this discussion, they created a system design that was tailored to the company's 

needs. In the design process, the author used the System Development Life Cycle (SDLC) technique. 

Keywords: Accounting Information System, Cash Receipt, Cash Disbursement, Microsoft 

Access. 

1. PENDAHULUAN  
Di era globalisasi saat ini, teknologi dan informasi terus berkembang dengan 

cepat. Penemuan baru dalam berbagai bidang teknologi menunjukkan keinginan manusia 
untuk terus menciptakan perubahan. Komputer adalah salah satu penemuan. Komputer 
adalah sekumpulan peralatan elektronik yang dapat menginput dan mengolahnya sesuai 
kebutuhan pengguna serta menghasilkan keluaran berupa informasi dalam berbagai 
tampilan, seperti teks, gambar, audio, video, dan audio-visual. Dari pengertian ini, 
komputer biasanya digunakan sebagai alat pengolahan data. Komputer di dunia bisnis, 
khususnya, menawarkan berbagai solusi untuk masalah, salah satunya adalah sistem 
informasi akuntansi. Sistem Informasi Akuntansi, yang kemudian disingkat SIA, adalah 
alat kecerdasan yang digunakan untuk memproses data, terutama transaksi keuangan 
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bisnis. Tujuannya adalah untuk membuat data yang dihasilkan lebih ringkas dan akurat. 
Bisnis mulai menggunakan sistem terkomputerisasi setelah SIA. Dengan menggunakan 
SIA dalam bisnis, pekerjaan dapat diselesaikan dalam waktu yang lebih singkat. Mulai 
dari penyimpanan, pembuatan laporan, dan pencarian data, proses penginputan dan 
pengaturan data juga menjadi lebih mudah. 

Ada banyak sistem informasi akuntansi di perusahaan, salah satunya berkaitan 
dengan penerimaan dan pengeluaran kas. Kas tidak boleh dipandang sebelah mata 
karena merupakan alat yang sangat penting bagi perusahaan. Karena kas sangat likuid 
dan dapat dipindah tangankan oleh pihak yang tidak bertanggung jawab, pengelolaan kas 
harus dilakukan secara tepat. Dalam hal ini, sistem terkomputerisasi dinilai mampu 
menyelesaikan ancaman tersebut. Namun, banyak bisnis masih menggunakan sistem 
terkomputerisasi untuk penerimaan dan pengeluaran kas secara manual saat ini. Salah 
satunya adalah CV Era Komputer Palembang. 

CV Era Komputer Palembang menjual perangkat komputer dan menyediakan 
layanan perbaikan. Perusahaan ini, yang berlokasi di Jalan Perindustrian II Pertokoan 
Tirta Mutiara Indah Blok A09 di Kelurahan Kebun Bunga, telah beroperasi selama hampir 
dua puluh lima tahun. Bapak Abdul Hadi menulis CV ini sejak 8 Maret 1998. Meskipun 
telah berdiri sejak lama, operasi perusahaan masih dicatat secara manual, terutama 
dalam sistem penerimaan dan pengeluaran kas. CV Era Komputer Palembang masih 
menggunakan buku untuk mencatat penerimaan dan pengeluaran uang. Buku ini berisi 
tanggal, detail transaksi, debet, kredit, dan saldo. Karena perusahaan menggunakan alat 
bantu kalkulator untuk menghitung setiap transaksi, kesalahan pengguna mungkin 
terjadi. Ini terutama benar ketika banyak data yang dihitung. Pencatatan buku tidak 
memiliki kelompok akun tertentu, sehingga kebingungan dalam pencarian data sering 
terjadi, yang menyebabkan pencarian data historis memakan waktu yang lama. Output 
dari proses pencatatan kas masuk dan keluar akan berupa laporan tentang uang yang 
diterima dan dikeluarkan dengan media kertas. Karena perusahaan tidak menyusun 
laporan arus kas setiap bulannya, kas bersih yang diperoleh belum terlihat secara jelas 
dan detail dalam situasi ini. 

CV Era Komputer Palembang menemukan bahwa ada kebutuhan untuk 
memperbaiki sistem pencatatan penerimaan dan pengeluaran kas saat ini. Sistem 
berbasis database dengan Microsoft Access dapat membantu dalam hal ini.  Beberapa 
kelebihan Microsoft access termasuk pengoperasian yang mudah dan biaya penanganan 
yang murah. Selanjutnya, aplikasi ini dapat menghasilkan laporan arus kas bulanan CV 
Era Komputer. CV Era Komputer akan menjadi lebih mudah untuk mencatat kas masuk 
dan keluar serta mengubah data sesuai dengan kebutuhan dengan membuat Sistem 
Informasi Akuntansi yang menggunakan Microsoft Access untuk penerimaan dan 
pengeluaran kas. Pilihan pencarian berdasarkan tanggal, indeks arus kas, atau akun-akun 
yang telah disediakan juga dapat membuat proses pencarian data lebih mudah. Dengan 
demikian, laporan dapat dibuat dengan lebih efisien dan efektif, yang pada gilirannya 
akan sangat membantu dalam proses pengambilan keputusan perusahaan. Dengan 
demikian, tim PKM memutuskan bahwa CV Era Komputer Palembang membutuhkan 
sistem informasi akuntansi sederhana berbasis Microsoft Access untuk memperbaiki 
sistem penerimaan dan pengeluaran kas perusahaan. Oleh karena itu, tim PKM akan 
melakukan Perancangan Sistem Informasi Akuntansi Penerimaan dan Pengeluaran Kas 
Menggunakan Microsoft Access di CV Era Komputer Palembang. 
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2. METODE  
Teknik pengumpulan data dilakukan dengan cara melakukan wawancara 

terhadap pemilik CV Era Komputer Palembang untuk memperoleh data-data terkait 
gambaran umum perusahaan dan segala informasi yang berkenaan dengan sistem 
penerimaan dan pengeluaran kas yang terjadi di perusahaan tersebut. Selanjutnya 
melakukan kegiatan wawancara pada tanggal 02 April 2023 dan bertempat di CV Era 
Komputer Palembang. 

Sumber data yang digunakan yaitu data primer dan data sekunder. Data primer 
berasal dari hasil wawancara langsung dengan pemilik CV Era Komputer Palembang 
mengenai gambaran umum perusahaan serta proses penerimaan dan pengeluaran kas 
yang terjadi. Data sekunder yang didapat berupa dokumen yang digunakan terkait sistem 
penerimaan dan pengeluaran kas, daftar penerimaan kas bulan Februari, Maret dan April 
2023, serta daftar pengeluaran kas bulan Februari, Maret dan April 2023. 

 
3. HASIL DAN PEMBAHASAN  
Analisis Sistem Akuntansi Penerimaan dan Pengeluaran Kas yang diterapkan CV Era 

Komputer 
Untuk penerimaan dan pembayaran, CV Era Komputer Palembang masih 

menggunakan sistem manual. Pengeluaran kas untuk pembayaran beban dan pembelian 
barang dagang, sementara pengumpulan kas berasal dari penjualan tunai dan jasa servis. 
Nota penjualan dan faktur pembelian, serta catatan laporan penerimaan dan pengeluaran 
kas, adalah dokumen yang digunakan. Tidak ada laporan arus kas karena kasir 
melakukan pencatatan secara manual, meskipun penjualan dan kas sudah berbeda. 
Namun, kasir masih melakukan akuntansi, yang meningkatkan kemungkinan 
kecurangan. Untuk mencegah kecurangan, pengendalian internal harus jelas 
memisahkan akuntansi dan kas. 

 
Perancangan Sistem Informasi Akuntansi Penerimaan dan Pengeluaran Kas 
Menggunakan Microsoft Access pada CV Era Komputer Palembang 

 Tujuan dari perancangan sistem informasi akuntansi penerimaan dan 
pengeluaran kas secara terkomputerisasi pada CV Era Komputer Palembang adalah 
untuk membuat proses pencatatan penerimaan dan pengeluaran kas lebih mudah. 
Berdasarkan hasil analisis sistem penerimaan dan pengeluaran kas CV Era Komputer 
Palembang, rancangan yang diusulkan adalah perancangan sistem informasi akuntansi 
penerimaan dan pengeluaran kas secara terkomputerisasi untuk CV Era Komputer 
Palembang. Berdasarkan hasil analisis terhadap sistem penerimaan dan pengeluaran kas 
pada CV Era Komputer Palembang maka rancangan yang diusulkan adalah perancangan 
sistem informasi akuntansi penerimaan dan pengeluaran kas dengan menerapkan 
metode System Development Life Cycle (SDLC), yang terdiri dari:  
 
Tahap Analisis Sistem Penerimaan dan Pengeluaran Kas pada CV Era Komputer 
Palembang 
• Analisis Metode PIECES: Evaluasi sistem lama berdasarkan kinerja, informasi, 

ekonomi, kontrol, efisiensi, dan layanan 
Kinerja: Sistem lama lambat, sistem baru diharapkan lebih cepat dan akurat. 
Informasi: Sistem baru memperbaiki keterlambatan dan kesalahan manual. 
Ekonomi: Sistem baru mengurangi biaya alat tulis. 
Kontrol: Sistem baru dilengkapi keamanan data (password). 
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Efisiensi: Sistem baru otomatisasi pencatatan dan hitungan. 
Layanan: Sistem baru mempermudah pencarian histori transaksi. 

• Analisis Kebutuhan Sistem: Identifikasi kebutuhan fungsional (fitur sistem) dan 
non-fungsional (operasional, kinerja, keamanan). 
Fungsional: Akses dengan password, input/edit transaksi, laporan otomatis dan 
real time. 
Non-Fungsional: 
Hardware: Spesifikasi minimal (RAM 512 Mb, Intel Premium). 
Software: Windows XP, Microsoft Access. 
Brainware: Operator untuk input, teknisi untuk pemeliharaan. 

• Analisis Kelayakan Sistem: Penilaian apakah sistem baru layak dari segi teknis, 
hukum, penjadwalan, dan operasional. 
Teknis: CV sudah memiliki komputer yang sesuai. 
Hukum: Sistem tidak melanggar hukum. 
Penjadwalan: Implementasi segera setelah selesai. 
Operasional: Sistem baru meningkatkan efisiensi dan akurasi informasi. 

 

Desain Sistem Informasi Akuntansi Penerimaan dan Pengeluaran Kas pada CV Era 

Komputer Palembang 

Tahapan desain ini dimulai dengan pembuatan database penyimpanan data ke 
dalam tabel-tabel yang dibutuhkan. Selanjutnya tabel-tabel tersebut akan dihubungkan 
sehingga terbentuk relationship yang berguna merelasikan isian tabel satu dan yang 
lainnya. Tabel-tabel tersebut kemudian akan menghasilkan keterkaitan satu sama lain. 
Output yang akan dihasilkan dari perancangan ini berupa laporan penerimaan kas, 
laporan pengeluaran kas, laporan arus kas, serta laporan arus kas berdasarkan kode 
akun. Berikut merupakan penjelasan tahap-tahap perancangannya. 
1. Pembuatan Database, Langkah awal ini melibatkan pembuatan wadah utama 

untuk menyimpan semua informasi terkait sistem penerimaan dan pengeluaran 
kas. Seperti membangun fondasi rumah atau membuat database baru di Microsoft 
Access. Adapun Langkah: Pilih blank database → Beri nama → Klik "Create". 

 
Gambar 1 Tampilan awal database. 

Sumber data: Data diolah, 2023 

 
2. Pembuatan Tabel, Setelah database siap, kita perlu membangun struktur di 

dalamnya. Tabel-tabel ini seperti rak-rak di dalam gudang, masing-masing 
dirancang untuk menyimpan jenis data tertentu (misalnya, data pelanggan, 
transaksi, atau inventaris). Setiap tabel memiliki kolom-kolom (field) yang 
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menentukan jenis informasi apa yang bisa disimpan di dalamnya. Tabel-tabel yang 
dibutuhkan: Index, Keterangan Transaksi, Kode Akun, Transaksi, Type Akun. 
Adapun Langkah: Pilih "Create" → "Table" → "Design View" → Isi field name dan 
data type → Save. 
 

 
Gambar 2. Tampilan dan struktur tabel 

Sumber data: Data diolah, 2023 

 
3. Pembuatan Entity Relationship Diagram (ERD), Langkah ini seperti membuat 

peta hubungan antar tabel. ERD menggambarkan bagaimana setiap tabel 
terhubung satu sama lain, sehingga kita dapat melihat gambaran besar bagaimana 
informasi mengalir dan berinteraksi dalam sistem. Adapun Langkah: Klik 
"Database Tools" → "Relationship" → Hubungkan field antara tabel-tabel yang 
terkait. 

 

 
Gambar 3. Tampilan ERD 

Sumber data: Data diolah, 2023 

 
4. Pembuatan Query, Query berfungsi seperti alat pencarian canggih di dalam 

database. Dengan query, kita dapat mengambil informasi spesifik dari tabel-tabel, 
menggabungkannya, atau memfilternya sesuai kebutuhan. Ini memungkinkan kita 
untuk melihat data dari berbagai sudut pandang dan menghasilkan laporan yang 
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bermakna.Adapun Langkah: Klik "Create" → "Query Design" → Pilih field → Save 
query. 

 
Gambar 4. Tampilan query untuk laporan 

Sumber data: Data diolah, 2023 
 

5. Pembuatan Form, Form adalah antarmuka yang akan digunakan pengguna untuk 
berinteraksi dengan sistem. Seperti dashboard mobil, form menyediakan cara 
yang mudah untuk memasukkan data, melihat informasi, dan melakukan tindakan 
lain dalam sistem. Membuat form untuk user interface, seperti form menu utama, 
input transaksi, dan laporan arus kas. Adapun Langkah: Klik "Create" → "Form 
Wizard" → Pilih tabel/query → Design form → Save. 

 
Gambar 5. Tampilan form utama 
Sumber data: Data diolah, 2023 
 

 
Gambar 6. Tampilan form input transaksi  

Sumber data: Data diolah, 2023 
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Gambar 7. Tampilan form laporan arus kas 

Sumber data: Data diolah, 2023 

 
6. Pembuatan Report, Report adalah hasil akhir yang disajikan kepada pengguna. 

Ini adalah rangkuman informasi yang telah diolah dan diformat sedemikian rupa 
sehingga mudah dibaca dan dipahami. Report dapat berupa laporan keuangan, 
analisis penjualan, atau informasi lain yang relevan dengan kebutuhan pengguna. 
Membuat report untuk laporan arus kas, penerimaan kas, dan pengeluaran kas. 
Adapun Langkah: Buka query → Klik "Create" → "Report" → Edit sesuai 
kebutuhan. 

 
Gambar 8. Tampilan report untuk laporan arus kas 

Sumber data: Data diolah, 2023 

 

 
Gambar 9. Tampilan report untuk laporan penerimaan kas 

Sumber data: Data diolah, 2023 
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Gambar 10. Tampilan report untuk laporan pengeluaran kas. 

Sumber data: Data diolah, 2023 

 
Implementasi Sistem Informasi Akuntansi Penerimaan dan Pengeluaran Kas 
Menggunakan Microsoft Access pada CV Era Komputer Palembang 
Dalam tahap implementasi ini, kegiatan dibagi menjadi beberapa bagian yaitu: 
1. Pengujian Sistem 

Pengujian sistem dilakukan untuk mengetahui apakah sistem yang dibuat dapat 
berjalan dengan baik sesuai dengan kebutugan. 

a. Proses Log in 
Program ini didesain dengan diawali proses log in. Tujuan dari proses log in ini 

adalah agar keamanan sistem yang dibuat dapat lebih terjaga sehingga pihak yang 
dipercaya saja yang dapat mengaksesnya. Dalam hal ini, hanya bagian kasir dan pimpinan 
saja yang dapat membukanya dengan password yang telah dibuat. Berikut ini merupakan 
tampilan awal log in 

 
Gambar 11. Log In 

Sumber: Data diolah, 2023 
 

b. Masuk ke Menu Utama 
Setelah tampilan awal muncul, pengguna akan dapat melihat button bertuliskan 

“Menu Utama”. Setelah melihat button tersebut, pengguna dapat langsung mengklik dan 
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selanjutnya tampilan menu utama akan terbuka. Berikut ini merupakan tampilan dari 
menu utama sistem penerimaan dan pengeluaran kas CV Era Komputer Palembang. 
 

 
Gambar 12. Menu Utama 

Sumber: Data diolah, 2023 

 
c. Input Transaksi 
Dalam proses ini pengguna melakukan kegiatan input transaksi kas yang terjadi 

pada perusahaan. Dengan mengklik button ”Input Transaksi” pada Menu Utama, 
pengguna akan langsung diarahkan pada tampilan form input transaksi. Dalam 
melakukan input transaksi ini, sangat diutamakan ketelitian dari pengguna sebab 
kegiatan ini merupakan penentu atas baiknya pelaporan kas nantinya. Pengguna harus 
teliti dalam menginput transaksi berdasarkan jenis transaksi, nomor transaksi, tanggal, 
keterangan transaksi, index, akun apa yang digunakan, serta jumlah debit maupun 
kreditnya. Seperti yang telah dijelaskan sebelumnya bahwa sistem input ini merupakan 
single entry yang berarti bahwa pengisian data pada form ini dilakukan sekali tiap 
penyimpanan. 

 

 

Gambar 13 Input Transaksi 
Sumber: Data diolah, 2023 

 
d. Proses Menampilkan Laporan 
Pada proses ini pengguna akan dipermudah untuk pembuatan laporan sesuai 

dengan tujuan dibuatnya sistem ini. untuk laporan yang dihasilkan yaitu laporan arus kas 
sebagai laporan utama dan terdapat 3 laporan lainnya yang penulis buat dengan tujuan 
dapat lebih memberikan informasi tambahan kepada perusahaan. Masing-masing dari 
laporan tersebut ialah laporan penerimaan kas, laporan pengeluaran kas, dan laporan 
arus kas berdasarkan kode akun. 

 
 



Jurnal Pengabdian Masyarakat Akuntansi, Bisnis & Ekonomi (JPMABE) 
Volume 2 Nomor 1, Januari – Maret 2024 
 

P-ISSN: 2963-4903                E-ISSN: 3031-8564 

 

33 
 

 
Gambar 14.  Menu Laporan 

Sumber: Data diolah, 2023 

2. Konversi Sistem 
Konversi sistem dilakukan untuk mengganti sistem lama dengan sistem yang 

baru. Konversi yang diterapkan pada CV Era Komputer Palembang dilakukan dengan 
mengoperasikan sistem baru bersama-sama dengan sistem lama, karena apabila terjadi 
kerusakan atau komputer mati maka sistem yang lama masih dapat digunakan dan usaha 
dapat berjalan seperti biasa. 

4. KESIMPULAN  
Berdasarkan hasil analisis dan pembahasan perancangan sistem informasi 

akuntansi penerimaan dan pengeluaran kas menggunakan Microsoft Access pada CV Era 
Komputer Palembang, dapat disimpulkan sebagai berikut; (1) Berdasarkan analisis yang 

dilakukan terhadap sistem penerimaan dan pengeluaran kas CV Era Komputer Palembang, 

yang mencakup dokumen, fungsi, prosedur, dan pengendalian internal sistem, ditemukan 

bahwa sistem akuntansi penerimaan dan pengeluaran kas CV Era Komputer Palembang masih 

dilakukan secara manual dan tidak memiliki sistem terkomputerisasi yang tersedia. Oleh 

karena itu, perancangan sistem informasi akuntansi penerimaan dan pengeluaran kas harus 

dimulai, dan; (2) Metode Life Cycle of System Development (SDLC) digunakan untuk 

melakukan tahap perancangan sistem. Pada tahap awal, CV Era Komputer Palembang dinilai 

mampu dan layak untuk memperbaiki sistem yang ada menjadi sistem komputerisasi. 

Implementasi sistem baru dimulai dengan memasukkan password dan input transaksi serta 

membuat laporan seperti laporan penerimaan dan pengeluaran uang, laporan arus kas, dan 

laporan arus kas dengan kode akun.  
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